
   

  Ethernet Sidescan Kit 
  445-042 APRIL 2006-REVISED JULY 2018 

Specifications subject to    Copyright © 2006 - 2019 
change without notice  www.imagenex.com Imagenex Technology Corp. 

SIDESCAN SONAR KIT  
(ETHERNET COMMUNICATIONS) 

  
 

 
 
 
 
HARDWARE 
SPECIFICATIONS: 
INTERFACE Ethernet 
FREQUENCY 260 kHz / 330 kHz / 800 kHz nominal 
TRANSDUCER BEAM WIDTH 260 kHz:  2.2° x 75°  

330 kHz:  1.8° x 60° 
800 kHz:  0.7° x 30°  

RANGE RESOLUTION Range scale ÷ 1000 
POWER SUPPLY Nominal 24 VDC (22 VDC – 33 VDC) at less than 2.5 Watts 
ELECTRONICS DIMENSIONS  
 
 
                     Narrow PCB Option: 

120.65 mm (4.75”) x 120.65 mm (4.75”) 
111.76 mm (4.4”) between mounting holes  
or 
88.9 mm (3.5”) x 165.1 mm (6. 5”) 
81.28 mm (3.2”), 157.48 mm (6.2”) between mounting holes

TRANSDUCER DIMENSIONS See drawing on p. 3 
WEIGHT:  In Air     Transducers  
  
                                Electronics       

385 g (0.8 lbs) each    
                          
121 g (0.3 lbs)      

 
 

Shown with standard transducers & board 



SOFTWARE 
SPECIFICATIONS: 

YellowFin_AUV.exe 

WINDOWS™ OPERATING SYSTEM Windows™ XP, Vista, 7, 8, 10 
ZOOM MODES 1x, 2x, 3x, 4x, and 5x dynamically moveable 
RANGE SCALES:      
                              

10 m, 20 m, 30 m, 40 m, 50 m, 60 m, 80 m, 100 m,  
125 m, 150 m, and 200 m 

FILE FORMAT (filename).872 
RECOMMENDED 
MINIMUM COMPUTER 
REQUIREMENTS: 

800MHz Pentium 3 
256 MB RAM 
2 GB Hard Disk 
1024 x 768 x 256 colour graphics 

 
COMMUNICATIONS PROTOCOL  
SPECIFICATIONS: 

 

ETHERNET INTERFACE SPECIFICATION 
(v1.00) 

Filename:   
Sidescan Ethernet Specification.pdf 

SOURCE CODE AVAILABLE FOR TESTING RecordData.cpp 
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Narrow PCB Option
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ORDERING  
INFORMATION: 
260 kHz / 330 kHz / 800 kHz UNIT 
with Remote Mount Faired Transducers 

Standard 896-000-150 

IP Address* Option                     -020 
Remote Mount Transducers with 24” pigtail** Option                     -025 
Remote Mount Transducers with connector** Option                     -026 
Narrow PCB Option                     -040 
 
*Note: Standard IP Address is 192.168.0.5   
 A different IP Address may be specified upon ordering. 
 
**Note:  Various connector/cable configurations available to be specified upon ordering. 

Product and company names listed are trademarks or trade names of their respective companies.
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What’s New in YellowFin 2.0  
 
Numerous updates and features have been added to YellowFin version 2.0. Some of the major features 
are listed below. 
 

• Added Event Marker capability to allow annotation of data files (See Section 3.8 on 
page 12). 

 
• Added GPS satellite information to indicate how many satellites are detected (See 

Section 5.6 on page 23 ). 
 

• Added Bitmap View display mode for rapid file playback (See Section 3.2 on page 6 ). 
 

• Added reverse file playback mode for enhanced file playback control (See Section 3.2 
on page 6 ). 
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1.0 System Description  
 
The Imagenex Model 872 "YellowFin" is a full-featured dual channel, high-resolution, side-scan sonar. The 
YellowFin is an affordable, user friendly system that incorporates a high speed Ethernet connection to 
your Windows™ based laptop or desktop PC. Integrated power and an optional differential-ready GPS 
receiver complete this fantastic system. Zoom windows are available for target investigation without 
interrupting real-time data acquisition. Data is displayed in real-time, with or without speed correction, in 9 
user selectable color tables. 

2.0 Getting Started:  
 
After you are sure you have correctly wired the system, turn the power on to the surface processor and 

your computer. After the operating system started, double click the program icon  on your desktop 
screen to launch the YellowFin program. You can exit this application by clicking the close window button 
at the upper right corner of the screen or use the menu command  
“File->Exit”. 
 
YellowFin.exe is a Windows program that controls, displays and records data from the YellowFin Sidescan 
Sonar System. The program uses a high speed Ethernet connection (10Mbps) to communicate with the 
Model 872 sonar processing unit. 
 
This document describes how to use the commands provided by the YellowFin program to control the 
Model 872 sonar unit and how to view the data. 
 

2.1 Screen Layout 
 
The default screen layout of YellowFin.exe program provides a vertically displayed sonar image with a 
user menu on top and a toolbar at left, as well as a status bar at the bottom in real-time data acquisition 
operation. If you run YellowFin.exe for file playback, there will be a Playback bar shown under the user 
menu. You can resize the sonar image display window and hide the toolbar or status bar by using the 
menu command: “View->Tool Bar” or “View->Status Bar” or  
“View->Playback Bar”. 
 

2.2 Operations: 
 
When you start running the YellowFin.exe program, it first prompts you with a dialog box asking if you 
want to run it in real-time sonar data acquisition mode or run file playback. If you want to run real-time 
sonar data, please click the “YES” button. The program will try to connect to the sonar head using the 
specified IP address. If you only want to playback a file, please click the “NO” button and the program will 
not connect to the sonar head. This also saves time in case there is no Ethernet connection available. 
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2.3 Interrogating the sonar unit: 
 
Real-time sonar data interrogation needs communication between the YellowFin program and the sonar 
unit. The communication protocol is based on high speed Ethernet. The YellowFin.exe program uses 
another thread to send operation commands to the sonar head and then receive sonar data returns. 
 
You can save real-time data to a file by using the menu command “File->Record Data” or clicking the 

Toolbar button  for post process or later inspection. Use the menu command “File->Stop Recording” 

or clicking the Toolbar button  to quit saving data. 
 

2.4 File playback: 
 
You can also use the YellowFin program to playback data that has been recorded to a file (with file 
extension ".872" or ".xtf").  
 
To open a .872 or .xtf data file to playback, use the menu command “File->Open a file” or click the Toolbar 

button . When the program is running with file playback, the frame window will show a File Playback 
dialogue bar under the main menu. You can drag and dock it to a convenient place on the screen. This 
dialogue bar lets you control the playback speed and playback file position. See the section “File Playback 
Progress Dialog Bar” section for details. 
 
Once you open a sonar data file to playback, the operation of real-time sonar data acquisition will stop. 
You can open only one data file to play back at a time. But you can open another data file to playback 
during file playback, the previously opened file will be closed. 
 
You can once again change the operation to real-time data interrogation by using the menu command 

“File->Connect…”,  “Communication->Reconnect” or click the Toolbar button . When the system 
starts to acquire data from sonar head, opened data file will be closed. If the Ethernet connection is lost or 
failed, you can use the menu command  
“Communication->Reconnect” to reconnect. 
 

 
Note : There are several things that can cause lost or failed connection. One is that the user 
turned the power to the surface processor off. The other is that the Ethernet connection is not 
configured correctly. 
 
 

The YellowFin program provides several convenient ways (menu commands, dialog boxes, and toolbar 
commands) to control the sonar unit’s operations, operating parameters, and data display windows. 
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2.5 Sonar Image Manipulation 
 
The YellowFin program uses a bitmap image with the size of the display screen to display the sonar 
image. When the program receives one sonar shot data either from real-time or playback, the data will be 
displayed at the top line of the image and the previous shots will be shifted down. 
 
You can use the command “Zoom In” or command “Zoom Out”  to zoom in or out the image and use the 
command “Hold” to pause the image display. When you zoom in, the image size will be larger than the 
display window size. Thus, some portion of the image will be hidden beyond the size of the display 
window. If you want to see the hidden part of the image, you can drag the image to let that part fall in the 
display window. You can move the image by holding down the left mouse button and dragging (moving) 
the image. When you release the left mouse button, the image dragging operation will stop. Use the 
command “Restore Image” to restore the sonar image to its original size and position. 
 

 
Note : If the hold command is activated during file record, data is still recorded although the 
display does not move. This allows the user to inspect an area of interest without losing any 
data 
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3.0 MAIN MENU 
 

 
Figure 1 - YellowFin Menus 

 

3.1 File menu commands 
 
The File menu offers the following commands: 
 
Connect to Sonar 
Head… 

Use this command to establish an Ethernet connection between the sonar 
head and the control computer. If the connection is established successfully, 
the YellowFin program will start to interrogate the sonar head for data in real-
time. This command is very useful when you change the operation from file 
playback to real-time data acquisition. If this command is disabled, which 
means the program is operating in real-time data acquisition mode not in file 
playback mode. If the connection has failed, after a minute or so, the program 
will display an error message “No Connection!”. You can check the wiring and 
reconnect the network again by using the “Communications->Reconnect” 
command. 
 
Shortcuts 

Toolbar Button:  
Keys:  Ctrl+N 
 

Playback…  Use this command to open a previously recorded YellowFin sonar data file 
(with the file extension .872 or .xtf) to play back. The YellowFin program 
displays the File Open dialog box so you can choose which file you want to 
open. 
 
Shortcuts 

Toolbar Button:  
Keys: Ctrl+O 
 

Record Data  or  
Copy Start… 
 
 

Use this command to save real-time sonar data to a file or copy part of a file to 
another one during playback. YellowFin displays the Save As dialog box so you 
can name your file. The file name can be any characters and digits combined. 
YellowFin will automatically add file name extension .872 or .xtf to your file 
name, depending on what file format you choose, so you don’t have to type the 
file extension. Then YellowFin will continue interrogating the sonar unit for data 
and at the same time recording those data to your named file.  
 
You can use the Stop Recording command to quit recording data. YellowFin 
then closes the named file. 
 
During file playback, “Record Data” is replaced with “Copy Start”. This allows 
you to copy data from one file to a separate file. 
 
Shortcuts 

Toolbar:  
Keys:  Ctrl+S 
. 
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Stop Recording  or  
Copy Stop 
 

Use this command to stop recording or copying sonar data to a file. YellowFin 
will close the file. You can use the “Playback…” command to open it for 
playback. 
 
Shortcuts 

Toolbar:  
Keys:  Ctrl+Z 
 

Settings Change 
Alarm 

New 

Use this command to play a sound when a setting changes during file playback 
Supported settings are: Range, Mode, and End of File  
 

Save Screen Use this command to save the whole sonar image to a named image file. The 
image file formats can be ".bmp", ".jpg", ".png", ".tiff”, and ".gif". 
 

Save Selected Use this command to save part of the sonar image to a named image file. The 
image file formats can be .bmp, jpg, .png, .tiff, and .gif.  
 
Note: Before you use this command, you should use toolbar “select” 

command to select an image area. Put the display on hold, then push the 

“select”  button and the program is in the select mode. Hold down the left 
button of your mouse at the start point and drag the mouse to the end point of 
your interested area and then release the button. The program will draw the 
selected area with dashed lines. If you are not satisfied about this selected 
area, you can select again and your first selected area will be discarded. After 
you selected an area, you can use this command to save it to an image file. 

You should click the “select”  button again to release this select mode so 
the program can respond to other commands. 
 
If there is no selected area available, this command will be disabled. 
 

Exit 
 

Use this command to terminate your YellowFin program. The system will save 
your display layout, sonar settings, and GPS configuration to a text file called 
YellowFin.ini. Next time you start the program, the system will load these 
settings from this file.  
 
Mouse: Double-click the application's Control menu button. 

 
Keys: ALT+F4 

 



Imagenex Technology Corp. ©2009  Model 872 ver 2.0 User’s Manual 

Page 6 of 39 

3.2 View menu commands 
 
The View menu offers the following commands: 
 
Clear Screen Use this command to clear the image in display window.  

 
Shortcuts 

Toolbar Button:  
Keys: c  
 

Grid Use this command to display and hide the vertical grid line. 
 

Grid Text Size Use this command to change the text size used as range text marks displayed 
at the bottom of the display window and measurement text marks. 
 

Hold Use this command to pause the image display. Toggle this command to pause 
or continue the image display. Note that this holds the display only. Data will 
still be recorded to the current file. 
 
Shortcuts 

Toolbar Button:  
Keys: h 
 

Bitmap View 
 
NEW 

Use this command to display the sonar data one screen at a time. Rather than 
the typical waterfall display, this display uses the standard Windows scroll bar 
to control the file position. Scrolling the bar up will advance the file forward, 
while scrolling the bar down will advance the file in reverse. 
 

Reverse Playback 
 
NEW 

Use this command to play the data file in reverse. 

Zoom In 
 

 

Use this command to zoom in the image. This command centers the zoom 
area on the mouse position. The zoom factors are 1x1, 2x2, 3x3, 4x4, and 5x5. 
 
Shortcuts 

Toolbar Button:  
Keys: z 
 

Zoom Out Use this command to zoom out the image.  
Shortcuts 

Toolbar Button:  
Keys: z 
 

Restore Image Use this command to restore the sonar image to its original size and position. 
When you move the image by clicking and dragging the image, and then zoom 
in/out on the image, the image may not be seen in the viewing window. Use 
this command to restore the image to its original size and position. 
 

Shortcuts 

Toolbar Button:  
Keys: r  
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Port Only Use this command to display only the Port channel. Note that, if recording a 

file, both channels are always recorded regardless of the display view. 
 

Stbd Only Use this command to display only the Starboard channel. Note that, if recording 
a file, both channels are always recorded regardless of the display view. 
 

Both Sides Use this command to display both Port and Starboard channels. 
 

Status bar Use this command to display and hide the status bar, which shows some of the 
important information in YellowFin, such as operating range, data gain, etc. A 
check mark appears next to the menu item when the Status bar is displayed. 
 

Toolbar Use this command to display and hide the toolbar, which includes buttons for 
some of the most common commands in YellowFin, such as playback and 
measurement commands, such as measure target height and measure 
distance. A check mark appears next to the menu item when the Toolbar is 
displayed. 
 

File Playback bar Use this command to display and hide the File Playback Progress dialog bar , 
which includes playback speed spin buttons and file playback progress display. 
A check mark appears next to the menu item when the File Playback bar is 
displayed. 
 

Show Range 
 

Use this command to show or hide the range display in the upper left corner of 
the image. 
 

Show Mark Shadow Use this command to show or hide the black background for the text marker 
display. 
 

Units Use this command to choose which display units you like to use. Range and 
distance can be displayed in meters (Metric) or feet (Imperial). 
 

Vertical Blending Use this command to blend data from adjacent pings. This technique uses the 
ships’ speed to determine bottom coverage, and is therefore only valid if the 
ships’ speed is not zero. 
 

Color Indicator Use this command to display and hide the color table indicator bar, which 
displays the color table used to represent echo strength. If enabled, this color 
table bar is displayed on the right side of the sonar image display window. The 
upper level colors represent higher echo strength, and lower level colors 
represent lower echo strength. A check mark appears next to the menu item 
when color table indicator bar is displayed. 
 
Use the menu command ColorTable to choose your preferred colors to display 
the sonar image. 
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3.3 Color Table Menu Commands 
 
The Color Table menu is used to change the sonar data colour palettes for the sonar images. 
  
YellowFin uses colours (called a colour table) to represent echo data strength (amplitude). For example: 
Normal High intensity color table used for mapping the echo data amplitude to 256 colors ranging from 
Black (low strength level) though blue, green, orange yellow white and red (highest strength level). 
 
The Color Table menu offers the following commands: 
 
Normal High Standard colour table used for mapping the echo data amplitude to 256 

colours ranging from Black (low level), through Blue, Green, Orange, Yellow, 
White and Red (highest level). 

Normal Low Same colours as Norm Hi, but uses a lower colour intensity. 
Green 256 shades of green. 
Grey 256 shades of gray (White on Black). 
Reverse Grey 256 shades of gray (Black on White). 
Brown/Yellow 256 mixed shades of brown and yellow. 
Green/Blue 256 mixed shades of green and blue. 
Green/Yellow 256 mixed shades of green and yellow. 
Blue 256 shades of blue. 

 

3.4 Settings Menu Commands 
 
The Settings menu offers the following commands: 
 
Sonar Settings  Display the Sonar Settings Dialog Box. If the dialog box is visible, 

this command will be disabled. 
 

See Sonar Settings  Dialog Box and Diagnostics Dialog Box for details about sonar settings and 
diagnostic items. 
 

3.5 Communication Menu Commands 
 
The Communication menu offers the following commands: 
 
Reconnect Use this command to re-establish the connection between the PC 

and the sonar head. This command is different from  
“File->Connect to Sonar Head…” which is used to change operation 
from file playback to real-time acquisition. The “Reconnect” 
command is used to reconnect the Ethernet link in real-time 
acquisition mode. 
 

Diagnostics  Display the Diagnostics Dialog Box. If the dialog box is visible, this 
command will be disabled. 
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3.6 Measure Menu Commands 
 
The Measure menu offers the following commands:  
 
Draw ‘+’ Mark This command is used to draw a mark (+) on the screen at the current mouse 

position by first clicking the command and then clicking the target that you 
want to draw the mark on. Repeat the operation to draw more marks. 
 
Shortcuts 

Toolbar Button:  
 

Measure Target Height This command is used to measure the approximate height off the bottom of a 
target (assuming a flat bottom). When selected, the cursor will display ‘Click 
on the Target ’. At this point, position the target cursor on the target of interest 
and press the left mouse button. A Horizontal rubber-banded line is drawn 
from the cursor position to the beginning of the transmit pulse with the 
message ‘Click on First (Bottom) Return ’. Position the cursor so that the 
end of the rubber-banded line is at the beginning of the bottom return (the end 
of the water column) and press the left mouse button again. The message 
‘Click on Shadow Start ’ is now displayed. Position the cursor at the 
beginning of the shadow that the target has cast and press the left mouse 
button. The message  
‘Click on  Shadow End – H = ???M ’ is displayed. Move the cursor to the end 
of the shadow to display the height measurement. Press the left mouse button 
again to begin a new measurement. 
 
Shortcuts 

Toolbar Button:  
 

Measure Range Measures horizontal (slant) range between the sonar and the target or current 
mouse position. Draws a horizontal line on the screen, with the range shown. 
 
This command is used to measure the range from the center of the sonar to a 
target. When you first click on the command, the YellowFin program will draw 
a temporary horizontal line from the center of the sonar to the current mouse 
position. Move the mouse to a selected target and the temporary horizontal 
line moves with the mouse. Click on the target,  the YellowFin.exe program 
will draw that horizontal line permanently. The Range mark ”xxx.x m” or “xxx.x 
ft” is shown at the end of the line. 
 
Shortcuts 

Toolbar Button:  
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Measure Distance Measures the distance between two targets. Draws a line on screen, with 

the distance shown. 
 
This command is used to measure the distance between two targets by 
clicking on one target and moving the cursor to the other target and clicking  
on it in the display window. This command draws a line connecting these two 
selected targets, a start symbol (+) and a stop symbol (+). The distance 
between these two targets is shown as “xxx.x m” or “xxx.x ft” at the end of the 
line. 
 
Note : The ship (or sensor) speed is needed to measure along track distance 
(along the ship heading direction) correctly.  
 
Shortcuts 

Toolbar Button:  
 

Clear Lines/Marks Deletes all lines and symbols and text marks drawn on the screen. 
 
Shortcuts 

Toolbar Button:  
 

 
 

Note : Since the sonar image is displayed as a moving picture, it is highly recommended that you 
place the display on hold before doing any measurements and clear those lines and marks 
before you release the hold status. If recording to a file, data will still be saved while the display is 
on hold. 
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3.7 GPS Options menu commands 
 
The Communication menu offers the following commands: 
 
Show GPS Track Plotter Use this command to open another window, which displays the 

sonar (or the ship) track plotted according to the GPS provided 
latitude and longitude information. 
 

GPS Comm Port Settings Configure the serial communication port for GPS data 
acquisition. The baud rate, stop bits, parity, etc. should match 
those of the GPS receiver. 
 

Speed Correction Use this command to enable or disable Speed Correction.  
 
The ship’s (or sensor) speed information is obtained from the 
system GPS receiver. The YellowFin program will use the ship’s 
speed and slant range information to adjust the aspect ratio of 
the sonar image. 
 

Convert UTC to Local Time Use this command to display the UTC time in local time 
coordinates. 

Synchronize with GPS Time 
 

Use this command to adjust the computer’s time to match the 
GPS time. 

Erase GPS Tracks 
New 

Use this command to clear the GPS track plotter window. 

Zoom in Use this command to zoom in the GPS track plot window using 
the following grid divisions: 10m, 20m, 50m, 100m, 200m, 500m, 
1000m. 
 
Shortcuts 
 
Keys: +, = 
 

Zoom out Use this command to zoom out the GPS track plot window using 
the following grid divisions: 10m, 20m, 50m, 100m, 200m, 500m, 
1000m. 
 
Shortcuts 
 
Keys: - 
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3.8 Events menu commands ( New) 
 
When recording real-time data to a file, events can be recorded at the same time.  
 

Note : The “.AN” annotation file is linked to the “.872” data file. Do not rename one file without 
renaming the other. Do not edit the “.AN” file. Failure to comply will result in errors, and/or lost 
event markers. 
 
 

 
The Events menu offers the following commands: 
 
Enable Event Input 
New 

Use this command to enable / disable event recording. This 
menu item is only active during file playback or while real-time 
data is being recorded. 
 

Hide Event Marker 
New 

Use this command to enable / disable event marker display on 
the screen. This menu item is only active during file playback or 
while real-time data is being recorded. 
 

Auto Event Info PopUp 
New 

Use this command to display the Event Information Dialog Box. 
Descriptions about this event may be entered in the annotation 
area. This menu item is only active during file playback or while 
real-time data is being recorded. 
 
 

Event Review/Edit 
New 

Use this command to review, edit, or delete an event/annotation. 
This menu item is only active during file playback or while real-
time data is being recorded. 
 

 
Real-Time 
To enable event recording, click the menu item "Events->Enable Event Input", then “double click” the 
target of interest. The Event Information Dialog Box will appear. Descriptions about this event may be 
entered in the annotation area. The event information will be written to an annotation file (using the same 

file name as the data file but with a “.AN” as the file extension), and an event mark  will be drawn at 
the cursor position. For each additional Event Mark, the number inside the circle will increase. Click 
"Cancel " to discard this event. Select "Events->Hide Event Marks" to hide the event marks. 
 
File Playback 
If there is an annotation file accompanied with this playback file, the event marks will be drawn on the 
sonar image when the file reaches the point where the event was recorded. 
 
More events may be added the same way as described in the real-time event recording method. Added 
events will be written to the same annotation file. If there is no annotation file for this data file, the program 
will create an annotation file and write the events info to it.  
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Figure 2 - Event Information Entry Dialog Box 

 
Menu items "Events->Auto Event Info PopUp" and "Events->Event Preview/Edit" are used for file 
playback. When you enable "Auto Event Info PopUp", an event info dialog box will appear when an event 
marker occurs. 
 

 
Figure 3 - Event Information Dialog Box 

 
By selecting "Events->Event Review/Edit", the descriptions of the events can be edited or deleted.  
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Figure 4 - Event Information Preview / Edit Dialog Box 

 
 
 

Note : The Latitude/Longitude used for the event is the GPS antenna position for the selected 
ping (i.e. offsets to the target are not calculated). 
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3.9 Help menu commands 
 

The Help menu offers assistance with this application:  
 
Beam Coverage Use this command to run the Sidescan beam coverage program which gives a 

graphical depiction of the area covered by the acoustic signal in different modes. 

About YellowFin Use this command to display the copyright notice and version number of your 
copy of YellowFin as well as contact information. 
 

Toolbar Button:  
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4.0 Toolbars and File Playback Progress Dialog Bar  

4.1 Main Toolbar 
 

 
Figure 5 - Main Toolbar 

The main toolbar is displayed at the left of the application window. The toolbar provides quick mouse 
access to many tools used in the YellowFin program. To hide or display the Toolbar, choose Toolbar from 
the View menu. 
 
Click To 

 Connect to sonar head. 

 Open an existing data file to play back. 

 Save real-time acquired sonar data to a file or copy playback data to another file. 

 Stop saving real-time data or stop copying playback data. 

 Increase operating range by one level.  
 

Range: 10m, 20m, 30m, 40m, 50m, 60m, 80m,  100m, 125m, 150m, and 200m for low  
and medium  frequency.  

 
Range: 10m, 20m, 30m, 40m, and 50m for high  frequency 
 

 Decrease operating range by one level. 

 Increase data (display) gain by 1% (0~100%). 

 Decrease data (display) gain by 1% (0~100%). 

 Clear the screen. 

 Toggle this command to pause or continue the image display. 

 Zoom in. The zoom factors are 1x1, 2x2, 3x3, 4x4 and 5x5 

 Zoom out. The zoom factors are 1x1, 2x2, 3x3, 4x4 and 5x5 

 Select an image rectangle area to save to an image file. 

 Draw a mark (+) on the screen at the current mouse position. 

 Measure target height. 

 Measure distance between two targets. 

 Measure slant range from the center of the sonar to the target. 

 Deletes all lines and marks drawn on the screen. 

 Restore image to its original size (1x1) and position. 

 Show the about dialog box displaying the copyright notice and version number of your copy of 
YellowFin as well as contact information. 
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4.2 File Playback Progress Dialog Bar 
 

 
Figure 6 - File Playback Progress Bar 

File Progress A slider bar with a pointer showing file playback position. Dragging the pointer to a 
new position will cause the file playback to start at that position. The slider range 
represents the file size. Note: You should always drag the pointer to a proper file 
playback position and avoid clicking on the edge of the slider bar, since that will 
cause the pointer stop moving as the file playback goes along. In that case, the 
pointer position will not reflect the file playback position correctly. You can drag 
the pointer once again to make the pointer move correctly. 
 

Play Back Speed Pressing the spin button up or down will change the playback speed faster or 
slower. The speed change will show in the adjacent progress bar. 
 

 
 
  
 
 
  
 



Imagenex Technology Corp. ©2009  Model 872 ver 2.0 User’s Manual 

Page 18 of 39 

5.0 Dialog Boxes  
 

5.1 Connection Dialog Box 
 

 
Figure 7 - Connection Dialog Box 

 
This dialog box will appear when you start your YellowFin program. If you are ready for real-time data 
acquisition, click the “YES” button. The program will connect to the sonar head via an Ethernet link. If you 
only want to playback data files, please click “No” and the program will conveniently display the “Open 
Data File” dialog box for you to choose a data file to playback. Please do not change the IP address as the 
sonar address is statically assigned from the factory. For more information, please refer to the “YellowFin 
Ethernet Setup Guide” available from Imagenex Technology Corp. 
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5.2 Open Data File Dialog Box 
 
The following options allow you to specify which file to open: 
 
File Name Type or select the filename you want to open. This box lists files with the 

extension you select in the Files of type box.  
 

Files of type Select the type of file you want to open: The supported file extensions are “.872” 
or “.xtf”. if opening a sonar data file. The file with file extension “.872” is the 
standard YellowFin recorded file format. YellowFin.exe can playback files with file 
extension “.xtf” (Triton Extended File Format) ONLY if the “.xtf” file is recorded by 
the YellowFin program. 
 

Drives Select the drive in which the YellowFin control software stores the file that you 
want to open.  
 

Directories Select the directory in which the YellowFin control software stores the file that you 
want to open. 
 

Network... Choose this button to connect to a network location where the data file resides. 
 

 

5.3 Save YellowFin Data File Dialog Box 
 
The following options allow you to specify the name and location of the file you're about to save sonar data 
into: 
 
File Name Type a new filename or select an existing file name to save sonar data into that 

named file.   
 

Drives Select the drive in which you want to store the document. 
 

Directories Select the directory in which you want to store the document. 
 

 
 



Imagenex Technology Corp. ©2009  Model 872 ver 2.0 User’s Manual 

Page 20 of 39 

5.4 Sonar Settings Dialog Box 
 

 
Figure 8 - Sonar Settings  Dialog Box 

 
The following options allow you to select sonar settings. These are the main parameters:  
 
Range Select the acoustic operating range.  

Options: 
Low Frequency: 10m, 20m, 30m, 40m, 50m, 60m, 80m, 100m, 

150m, and 200m. 
 
Medium Frequency: 10m, 20m, 30m, 40m, 50m, 60m, 80m, 100m, 

150m, and 200m. 
 
High Frequency:  10m, 20m, 30m, 40m, 50m 

 
Data Gain (Display Gain) Choose a Data Gain you want (from 0 to 100%). Data Gain is used 

to increase or decrease the intensity (color levels) of the sonar image. 
 

Mode/Freq There are three frequencies to choose from: low, medium and high.  
 

Gain Balance Gain balance is used to adjust the balance of the Port/Starboard image. Drag the 
gain balance slider bar to change the gain balance, which can be adjusted from    
-3dB to +3dB. The “Port (dB)” and “Stbd (dB)”edit boxes are only used for display 
purposes. 
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5.5 Diagnostics Dialog Box 
 

 
Figure 9 - Diagnostics Dialog Box 

 
The Diagnostics Dialog Box is used to display important system variables. This dialog box is very useful 
when trouble shooting the system in real-time. In file playback, certain system variables such as Header, 
Serial Stat, and Run-Type etc. are not available to display since they are not recorded into the data file. 
 

Header Sent by the sonar head (wet end) to tell the processor what kind of data format it 
sent, IGX for YellowFin sonar data. 
 

Serial Stat Indicates if the communication between sonar system and processor is normal 
(0x40 or 0x42) or not (other than 0x40 or 0x42). 
 
 

Run-Type Sent by the sonar head (wet end) to tell the YellowFin program what command 
the sonar is responding.  
 
0: standard sonar shot 
1: set Mode/Freq 
2: set Range 
3: set Gain Balance 
 

Mode/Freq   0: Low frequency  
1: Medium frequency  
2: High frequency 
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Range Index  
   
 

Current YellowFin sonar operating range index.  
5:   10m 
6:   20m 
7:   30m 
8:   40m 
9:   50m 
10: 60m 
11: 80m 
12: 100m 
13: 125m 
14: 150m 
15: 200m 

 
Range   
 

Current YellowFin sonar operating range. 

Data Gain  
  

Current YellowFin sonar operating Data Gain. 

Gain Balance  
  

Current YellowFin sonar operating Gain Balance. 

Link Command Sent by the YellowFin program to sonar head indicating the operating parameters 
are changed by the user. 
 

0: standard sonar shot 
1: set Mode/Freq 
2: set Range 
3: set Gain Balance 

 
PRF Milliseconds elapsed between two consecutive interrogations of the sonar head. 
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5.6 GPS Serial Port Configuration Dialog Box 
 
The GPS Serial Port Configuration Dialog Box is used to configure the GPS serial communications on 
your PC.  
 
Com Port 
  

Specifies the communication serial port to be used. 
 

Baud Rate  
 

Specifies the baud rate at which the GPS communications operates. The default 
is set to use 4800 bits/second baud rate. 
 

Data Bits  Specifies the number of bits in the bytes transmitted and received. The default is 
set to use 8 bits byte size. 
 

Parity  Specifies the parity scheme to be used. The default is set to use No Parity 
scheme. 
 

Stop Bits Specifies the number of stop bits to be used. The default is set to use one stop 
bit. 
 

Flow Control Not used 
 

Select NMEA 
Sentences 

Specifies GPS sentence types to be used. The default is set to RMC. 
 

GPS Output Time Specifies rate at which GPS data is output to the PC. This value must be set to 
match actual GPS settings (The Imagenex GPS is preset to 1 second). 

GPS Quality / 
Status 

This diagnostic value is read from the GPS receiver and provides the quality of 
received GPS data. 

Number of 
Satellites in Use 

This diagnostic value is read from the GPS receiver and provides the number of 
satellites the GPS has found. 

 
Note . “GPS Quality / Status” and “Number of Satellites in Use” values are dependant on the selected 
NMEA sentence: 
 
GPS Quality / Status  => GGA => 0 = Fix not available, 1 = Non-differential fix available. 
    GLL  => 0 = Fix not available, 1 = Non-differential fix available.  
    RMC => A = Valid position, V = NAV receiver warning. 
 
Number of Satellites in Use =>   GGA => 0 – 12 
    GLL  => Not available. 
    RMC => Not available. 
 
 
 

The Baud Rate, Data Bits, Parity, and Stop Bits should match those in the GPS receiver specifications. 
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Figure 10 - GPS Serial Port configuration Dialog Box 
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Appendix A – Target Height Calculation  
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Figure 11 - Target Height Calculation 
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Appendix B – External Resources  
 
The YellowFin Sonar System provides several aids for post processing and/or controlling sonar data. 
When recording a file, one may choose to record the data in an “.xtf” or “.872” format. YellowFin.exe is 
able to playback an “.xtf” file that was recorded using YellowFin.exe. Also, Data from a “.872” or an “.xtf” 
file may be “copied” to an .xtf file using the Copy Start and Copy Stop commands in the File Menu. 
 
Once the “.xtf” file is generated, post processing may be done on this file. The following companies 
provide post processing software packages: 
 

• Chesapeake Technology, Inc. (http://www.chesapeaketech.com) 
• HYPACK inc. (http://www.hypack.com) 
• Quality Positioning Services (http://www.qps.nl) 
• CARIS (http://www.caris.com) 
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Appendix C – Data Storage File Format (.872)  
 
When recording the YellowFin data to a .872 file, the following bytes are appended and saved to the file 
every ping. The total number of bytes ‘N’ for each ping is equal to 4096. 
 
 

Byte # Byte Description 
0-999 File Header  (1000 bytes) 
1000-1999 Port Channel Echo Data  (1000 bytes) 
2000-2999 Starboard Channel Echo Data  (1000 bytes) 
3000-3nnn GPS Strings  (100 bytes/string) 
3nnn-4093 Zero Fill 
 
 
4094-4095 

Pointer To Previous Ping 
The last 2 bytes of this ping contain a 16-Bit number that is the sum of the 
number of bytes for this ping and the number of bytes for the previous ping. 
This number can be used for reverse playback synchronization. 
Number of bytes to previous ping = ((Byte 4094)<<8) | (Byte 4095) 

 
 
FILE HEADER 
 
Bytes 0 through 999 contain the following File Header  information: 
 
Byte 0  ASCII '8'  
Byte 1  ASCII '7'  
Byte 2  ASCII '2' 
 
Byte 3  872 File Version  
  0 = v1.xx – 1000 points/channel, 8-Bit data 
 
Bytes 4-7 Ping Number  – increment for every ping 
 

Byte 4 Byte 5 Byte 6 Byte 7 
7 - 0 7 – 0 7 - 0 7 - 0 
Ping Number 

 
Bytes 8-9 Total Bytes ‘N’  - number of bytes that are written to the disk for this ping 
 

Byte 8 Byte 9 
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 
N = 4096 
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Bytes 10-11 Data Points Per Channel  
 

Byte 10 Byte 11 
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 
1000 

 
Byte 12  Bytes Per Data Point 
  always 1 
 
Byte 13  Data Point Bit Depth 
  always 8 
 
Byte 14  GPS Type/ Number of GPS Strings 
 GPS Type indicates which NMEA 0183 message was selected by the user and used for 

decoding Lat/Lng coordinates. Number of GPS Strings indicates how many GPS strings 
were detected and stored. Each string is stored (in ASCII) exactly as it appeared at the 
serial communications port during real-time data acquisition. The strings are stored in a 
100 byte slots starting at GPS String File Offset (Bytes 15-16). 

 
Byte 14 
7 6 5 4 3 2 1 0 
GPS Type Number of GPS Strings 

 
 GPS Type : 
 0 � $GPGLL 
 1 � $GPGGA 
 2 � $GPRMC 

 
 NMEA 0183 GPS Strings stored at the following offse ts : 
 $GPGLL: stored at GPS String File Offset + 0 
 $GPGGA: stored at GPS String File Offset + 100 
 $GPRMC: stored at GPS String File Offset + 200 
 $GPVTG: stored at GPS String File Offset + 300 

 
Bytes 15-16 GPS String File Offset  
 

Byte 15 Byte 16 
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 
Offset = 3000 

 
Bytes 17-18 Event/Annotation Counter 
 

Byte 17 Byte 18 
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 
E Count:   0 to 32767 

 
 E = 0, no event, ignore count 
 E = 1, new event, increment count and append annotation file 
 Annotations are stored in “filename.an” 
 Each annotation contains a maximum of 512 characters. 

 
Bytes 19-30 Date – system date, null terminated string (12 bytes) 

 "DD-MMM-YYYY" 
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Bytes 31-39 Time  – system time, null terminated string (9 bytes) 
 "HH:MM:SS " 

 
Bytes 40-44 Thousandths of Seconds  – system time, null terminated string (5 bytes) 

 ".ttt " 
 
Byte 45  Operating Frequency  

 0 = Low Frequency 
 1 = Medium Frequency 
 2 = High Frequency 

 
Byte 46  Range Index  – index numbers for acoustic operating range 

 5 - 10m 
 6 - 20m 
 7 - 30m 
 8 - 40m 
 9 - 50m 
 10 - 60m 
 11 - 80m 
 12 - 100m 
 13 - 125m 
 14 - 150m 
 15 - 200m 

 
Byte 47  Data Gain 
  YellowFin - 0 to 100 
  YellowFin AUV - 0 to 40 
 
Byte 48  Channel Balance  

 0 to 60 � +/-3dB in 0.1dB increments 
 0 = +3dB Port / -3dB Stbd 
 30 = 0dB for both channels 
 60 = -3dB Port / +3dB Stbd 

 
Bytes 49-50 Repetition Rate  – Time between pings 
 

Byte 49 Byte 50 
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 
Repetition Rate (ms) 

 
Bytes 51-52 Sound Velocity  
 

Byte 51 Byte 52 
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 
Sound Velocity (in meters/second) * 10 

 
Bytes 53-65 12 Byte File Header . Refer to the section “Interface Return Data” in the document 

“YellowFin Ethernet Specification” for further details.  
 
Bytes 66-69 Reserved  - always 0 
 
Byte 70  Sonar Type 
  0 – YellowFin 
  1 – YellowFin AUV 
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Byte 71   Real Range 
   10, 20, 30, 40, 50, 60, 80, 100, 150, 200 
   
Bytes 72-999  Reserved 

always 0 
 

Bytes 1000-1999 Port Channel Echo Data  
   1000 data points (1 byte/point) 
   first range point = 1 * Range / 1000 in meters 
   last range point = 1000 * Range / 1000 in meters 
   intensity: 0 – 255 
 
Bytes 2000-2999 Starboard Channel Echo Data  
   1000 data points (1 byte/point) 
   first range point = 1 * Range / 1000 in meters 
   last range point = 1000 * Range / 1000 in meters 
   intensity: 0 – 255 
 
Bytes 3000-3nnn GPS Strings  – (100 bytes/string) 
 
Bytes 3nnn-4093 Zero Fill  
 
Bytes 4094-4095 Pointer to Previous Ping  
 

Byte 4094 Byte 4095 
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 
Number of bytes to previous ping = 8192 
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Appendix D – Annotation File Format (.AN)  
 
The .AN File is generated / updated whenever an event marker is created. It is an ASCII text file which 
contains pointers to the location in the .872 file where the event occurs. It also contains the GPS 
coordinates, date and time, and user entered text. Refer to page 12 for details on event marker creation. 
 

Note : The “.AN” annotation file is linked to the “.872” data file. Do not rename one file without 
renaming the other. Do not edit the “.AN” file. Failure to comply will result in errors, and/or lost 
event markers. 
 
 

 
ID Number  - 0-99 
Ping number – Ping number in the .872 file that this event is referenced to. 
X-coordinate ratio - Location of the event in the current ping. 
Date – System date, null terminated string (12 bytes) 

 "DD-MMM-YYYY" 
 
Time  – System time, null terminated string (9 bytes) 

 "HH:MM:SS " 
 
GPS Ships Position Latitude  – text string (14 bytes) 

“_dd.mm.xxxxx_N ” 
dd = Degrees 
mm = Minutes 
xxxxx = Decimal Minutes 
_ = Space 
N = North or S = South 

 
GPS Ships Position Longitude  – text string (14 bytes) 

“ddd.mm.xxxxx_E ” 
ddd = Degrees 
mm = Minutes 
xxxxx = Decimal Minutes 
_ = Space 
E = East or W = West 

 
User comment  – 512bytes 
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Appendix E – Ethernet Interface Specification (V1.0 1) 
 
OVERVIEW 
 
The Interface Board (160-017.V3) communicates via an Ethernet connection to Windows based PC. 
The PC software needs to know the IP address and the correct port number of the sonar in order to create 
a socket. If a direct Ethernet connection is used, then the PC’s Ethernet card must have a statically 
assigned IP and Subnet Mask matching that of the sonar. If running through a local area net work, then 
the PC’s Ethernet card may have dynamically allocated IP but the sonar’s IP address MUST be 
reassigned to that matching the LAN. 
 
To interrogate the underwater unit and receive echo data, a “Switch Data Command” string is sent to the 
interface board, which, in turn, translates the data and sends “Sonar Control Commands” to the 
underwater unit. When the Sonar Control Command is accepted, the sonar transmits, receives, and sends 
its return data back up to the interface board. The interface board then packages the received data and 
sends it back to the PC which, in turn, processes and plots the data. 
 
To receive one sonar shot of acoustic data: 
 

1. Send a TCP packet containing the Switch Data Command (with byte 18: Packet = 
0x00). 

 
2. Receive a TCP packet containing the Port channel’s data. 
 
3. Send a TCP packet containing the Switch Data Command (with byte 18: Packet = 

0x02). 
 
4. Receive a TCP packet containing the Starboard channel’s data. 

 
The Interface Return Data is the same for Port and Starboard returns. However, the packet number and 
actual data reflect the different channels. 
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SWITCH DATA COMMAND (PC to Interface Board)  
 
The interface board accepts up to 27 bytes of switch data from the PC and must see the “Switch Data 
Header” (2 bytes: 0xFE and 0x44 hexadecimal) in order to process the switches. The interface board will 
stop accepting switch data when it sees the termination byte (0xFD HEX). The termination byte must be 
present for the interface board to process the switches. 
 

Note: the Termination Byte is the only switch value  allowed to have a 
value of 0xFD. All other switches should be set hig her or lower than 0xFD 
(253 Decimal) so they are not interpreted as a term ination byte!  

 

Table 1 - Switch Data Command To 160-017.v1 Interface board 

Byte # Description 
0 – 7 0xFE 0x44 Reserved Range Reserved 

 
Reserve

d 
Master/ 
Slave 

Mode/Freq 

8 – 15 Data 
Gain 

Reserved Balance 
Gain 

Reserved Reserved Link 
Comman

d 

Reserve
d 

Reserved 

16 – 23 Reserved Reserved TCP 
Packet 

Reserved Reserved 
 

Reserve
d 

Reserve
d 

Reserved 

24 – 26 Reserved Reserved Term. 
0xFD 

  
 

   

 
BYTE DESCRIPTIONS 
 
Note: All Byte values are shown in decimal unless noted with a '0x' (hexadecimal) prefix. 
 
Byte 0  Switch Data Header (1st Byte)  
  Always 0xFE (254 decimal) 
 
Byte 1  Switch Data Header (2nd Byte)  
  Always 0x44 (68 decimal) 
 
Byte 2  Reserved 

0 
 

Byte 3 Range 
0x05 – 0x0F 
Operating range: 10, 20, 30, 40, 50, 60, 80, 100, 125, 150, 200m 
 

Byte 4 Reserved 
0 
 

Byte 5  Reserved 
0 

 
Byte 6  Master/Slave  
  Not used (0x43) 
 
Byte 7  Mode / Frequency 

0. Low Frequency 
1. Medium Frequency 
2. High Frequency 
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Byte 8 Data Gain 
0 – 100% 
 

Byte 9 Reserved 
0 
 

Byte 10 Balance Gain  
Integer values 0 through 60 decimal generates a matched gain balance in .1db 
increments. 

 

  Starboard gain (dB) = 
10

30−x
 

  Port gain (dB) = 
10

30 x−
 

 
  Example x = 42 

   Starboard gain (dB) = dB2.1
10

3042 =−
 

   Port gain (dB) = dB2.1
10

4230 −=−
 

Byte 11 Reserved 
0 

 
Byte 12 Reserved   

0 
 
Byte 13 Link Command (3 bits)  
  Down Telemetry value to YellowFin head  
 

000 Standard Sonar Shot 
001 Set Mode / Freq 
010 Set Range 
011 Set Gain Bal 
100 Reserved 
101 Reserved 
110 Reserved 
111 Link to Link 

 
Byte 14 Reserved 

0 
 
Byte 15 Reserved  

0 
  
Byte 16  Reserved 

0 
 
Byte 17  Reserved 

0 
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Byte 18 TCP Packet Number (3 bits)  
Indicates which TCP formatted packet is requested from the PC. The Sonar shot is 
initiated on receipt of TCP Packet number = 0x00. Data is collected for both Port and 
Starboard channels. Port data is then sent to the PC. On receipt of 0x02, Starboard Data 
(which is already collected) is sent to the PC. 

 
  0x00 - Initiate Sonar Shot and return first TCP packet (Port data) 

0x01 - Reserved 
0x02 - Return second TCP packet (Starboard data) 
0x03 - Reserved 
0x04 -> 0x07 - Reserved 

 
Byte 19  Reserved 
  0 
 
Byte 20  Reserved 
  0 
 
Byte 21  Reserved 
  0 
 
Byte 22  Reserved 
  0 
 
Byte 23  Reserved 
  0 
 
Byte 24  Reserved 
  0 
 
Byte 25  Reserved 
  0 
 
Byte 26  Termination Byte  
  The Interface board will stop looking for Switch Data when it sees this byte. 
  Always 0xFD (253 decimal) 
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INTERFACE RETURN DATA 
 
After every shot, the interface board returns a 12 byte header, 1000 points of echo data, and a 
terminating byte  value of 0xFC. The total number of bytes (N), including the 12 byte header, returned 
will be 1013. 
 

Table 2 – YellowFin Return Data From 160-017.v3 Interface board to PC 

Byte # Description 
0 to 7 ASCII 

'I' 
ASCII 

'G' 
ASCII 

'X' 
Serial 
Status 

Sync byte 
(LO) 

Sync byte Sync 
byte 

Sync byte 
(HI) 

8 to 11 Sync Val 
(LO) 

Sync Val 
(HI) 

Data 
Bytes (HI) 

Data 
Bytes 
(LO) 

    

12 to 
(N-2)  

Echo Data 
1000 Data Bytes 

N-1 Term. 
0xFC 

 
 
 
BYTE DESCRIPTIONS 
 
Note : All Byte values are shown in decimal unless noted with a '0x' (hexadecimal) prefix. 
 N = total number of return bytes 
 
Byte 0 - 2 Imagenex Return Data Header  
  ASCII 'IGX' 
  'I' = 0x49, 'G' = 0x47, 'X' = 0x58 
 
  ASCII 'IGX'   
  N = 1013, (1000 Data Bytes, 12 header bytes, 1 termination byte) 
 
Byte 3  Serial Status 
 

Bit 7 Bit 6 Bit 5 Bit 4 Bit 3 Bit 2 Bit 1  Bit 0  

1 = 
Character 
Overrun 

1 = Switches 
Accepted 

0 0 0 0 Channel  

     1 = Switch 
Error 

0 0 Port 

      0 1 Reserved 
      1 0 Starboard 
      1 1 Reserved 
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Byte 4-7 Sync message bytes 
 

Byte 4 Byte 5 Byte 6 Byte 7 
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 
0 0 Sync Message 

(LO) 
0 0 Sync Message 0  0 Sync Message 0  0 Sync Messages 

(HI) 
 
YellowFin Sync messages: 23 bits 
YellowFin Sync messages:  
(byte [4] & 0x3F) | (byte [5]<<6 & 0x0FFF) | (byte [6]<<12 & 0x3FFFF) | (byte 
[7]<<18&0x7FFFFF) 

 
 
Sync Messages: 
 
Sync Word: 

22 21 20 19 18 17 16 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0 
1 1 0 0 Reserved (0’s) Information Run Type 1  

 
Bits 22-21:  Trigger  (11) 
 
Bits 20-19:  Head ID (00) 
 
Bit 0:  Stop bit  (1) 
 
Bits 4-1:  Run Type  (Echo’s Link Control Bits) 

 
  (0000) Sonar data 
  (0001) Mode / Freq 
  (0010) Range 
  (0011) Gain Balance 
  (0100) Reserved 
  (0101) Reserved 
  (0110) Reserved 

 
Bits 12-5:  Information 
 
  If Run Type = 0 or Run Type = 2  
  Range Index :  
   0x05 through 0x0F  

Operating range: 10, 20, 30, 40, 50, 60, 80, 100, 125, 150, 200m 
 

  If Run Type = 1  
  Mode / Frequency :  
   0x00 through 0x02  

0. Low Frequency 
1. Medium Frequency 
2. High Frequency 

 
  If Run Type = 3  
  Gain Balance :  
   Integers 0 through 60  
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Bits 18-13:  Reserved 
 
 
Byte 8,9 Sync Value  
 

Byte 8 Byte 9 
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 
0 Sync Value (LO) 0 Rx Sync Value (HI) L 

 
   Sync value is used for diagnostics (normal sync value is around 800). 
   Sync Value Byte (LO), Sync Value Byte (HI) 
 
   Sync Value Byte (LO)= (Byte 9 & 0x01)<<7 | (Byte 8 & 0x7F) 
    Sync Value Byte (HI)= (Byte 9 & 0x3E)>>1; 
    Sync Value = (Sync Value Byte (HI)<<8) | Sync Value Byte (LO) 
 
   No_RX_Data = Byte 9&0x40 
    If No_RX_Data = 1, low or no sync value  
    If No_RX_Data = 0, normal sync value  
 
Byte 10,11 Number of data bytes 
 
  Number of Echo Data Bytes returned 
  Data Bytes (LO), Data Bytes (HI) 
 

Byte 10 Byte 11 
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 

Data Bytes (HI) Data Bytes (LO) 
 
  Data Bytes = (Data Bytes High Byte<<8) | Data Bytes Low Byte 
 
Byte 12 Start of Echo Data  
  (N-12) Bytes of data 
 
   1st Range Point = Byte 12 
   2nd Range Point = Byte 13 
   3rd Range Point = Byte 14 
   4th Range Point = Byte 15 
   etc. ... 
 
Byte (N-2) End of Echo Data  
 
Byte (N-1) Termination Byte  
  0xFC 
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Appendix F – Wiring Diagrams  
 

YellowFin Tow Cable
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01
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Figure 12 - YellowFin Tow Cable Wiring Diagram 
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OVERVIEW  
 
The Side Scan Board (170-025.V1) communicates via an Ethernet connection to 
Windows based PC. The PC software needs to know the IP address and the correct port 
number of the sonar in order to create a socket. If a direct Ethernet connection is used, 
then the PC’s Ethernet card must have a statically assigned IP and Subnet Mask matching 
that of the sonar. If running through a local area net work, then the PC’s Ethernet card 
may have dynamically allocated IP but the sonar’s IP address MUST be reassigned to 
that matching the LAN. 
 
To interrogate the underwater unit and receive echo data, a “Switch Data Command” 
string is sent to the Side Scan Board, which, in turn, transmits, receives and sends its 
return data back up to the PC which, in turn, processes and plots the data. 
 
To receive one sonar shot of acoustic data: 
 

1. Send a TCP packet containing the Switch Data Command (with byte 
18: Packet = 0x00). 

 
2. Receive a TCP packet containing the Port channel’s data. 
 
3. Send a TCP packet containing the Switch Data Command (with byte 

18: Packet = 0x02). 
 
4. Receive a TCP packet containing the Starboard channel’s data. 

 
The Interface Return Data is the same for Port and Starboard returns. However, the 
packet number and actual data reflect the different channels. 
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SWITCH DATA COMMAND (PC to Interface Board)  
 
The Side Scan Board accepts up to 27 bytes of switch data from the PC and must see the 
“Switch Data Header” (2 bytes: 0xFE and 0x44 hexadecimal) in order to process the 
switches. The Side Scan Board will stop accepting switch data when it sees the termination 
byte (0xFD HEX). The termination byte must be present for the Side Scan Board to process 
the switches. 
 

Note: the Termination Byte is the only switch value allowed to 
have a value of 0xFD. All other switches should be set higher or 
lower than 0xFD (253 Decimal) so they are not interpreted as a 
termination byte! 

 

Table 1 - Switch Data Command To 160-017.v1 Interface board 

Byte # Description 
0 – 7 0xFE 0x44 Reserved Range Reserved 

 
Reserved Master/ 

Slave 
Mode/Freq 

8 – 15 Data Gain Reserved Balance 
Gain 

Reserved Reserved Reserved Reserved Reserved 

16 – 23 Reserved Reserved TCP 
Packet 

Reserved Reserved 
 

Reserved Reserved Reserved 

24 – 26 Reserved Reserved Term. 
0xFD 

  
 

   

 
BYTE DESCRIPTIONS 
 
Note: All Byte values are shown in decimal unless noted with a '0x' (hexadecimal) prefix. 
 
Byte 0  Switch Data Header (1st Byte) 
  Always 0xFE (254 decimal) 
 
Byte 1  Switch Data Header (2nd Byte) 
  Always 0x44 (68 decimal) 
 
Byte 2  Reserved 

0 
 

Byte 3 Range 
0x0A – 0xC8 
Operating range:  

Low Frequency: 10, 20, 30, 40, 50, 60, 80, 100, 125, 150, 200m 
Med Frequency: 10, 20, 30, 40, 50, 60, 80, 100, 125, 150, 200m 
High Frequency: 10, 20, 30, 40, 50m 
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Bytes 4-6 Reserved 
0 
 

Byte 7  Frequency 
0. Low Frequency 
1. Medium Frequency 
2. High Frequency 

 
Byte 8 Start Gain 

0 – 40dB 
 

Byte 9-17 Reserved 
0 
 

Byte 18 TCP Packet Number (3 bits) 
 Indicates which TCP formatted packet is requested from the PC. The Sonar 

shot is initiated on receipt of TCP Packet number = 0x00. Data is collected for 
both Port and Starboard channels. Port data is then sent to the PC. On receipt 
of 0x02, Starboard Data (which is already collected) is sent to the PC. 

 
   0x00 - Initiate Sonar Shot and return first TCP packet (Port data) 

0x01 - Reserved 
0x02 - Return second TCP packet (Starboard data) 
0x03 - Reserved 
0x04 -> 0x07 - Reserved 

 
Byte 19-26 Reserved 
  0 
 
Byte 26 Termination Byte 
  The Side Scan Board will stop looking for Switch Data when it sees this byte. 
  Always 0xFD (253 decimal) 
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INTERFACE RETURN DATA  
 
After every shot, the Side Scan Board returns a 12 byte header, 1000 points of echo data, and 
a terminating byte value of 0xFC. The total number of bytes (N), including the 12 byte 
header, returned will be 1013. 
 

Table 2 – YellowFin Return Data from 170-025.v1 Side Scan Board to PC 

Byte # Description 

0 to 7 
ASCII 

'I' 
ASCII 

'V' 
ASCII 

'X' 
Serial Status Range Freq Version Reserved 

0 

8 to 11 
Reserved 

0 
Reserved 

0 
Data Bytes 

(HI) 
Data Bytes 

(LO) 
    

12 to 
(N-2) 

Echo Data 
1000 Data Bytes 

N-1 
Term. 
0xFC 

 

 
 
BYTE DESCRIPTIONS 
 
Note: All Byte values are shown in decimal unless noted with a '0x' (hexadecimal) prefix. 
 N = total number of return bytes 
 
Bytes 0 - 2 Imagenex Return Data Header 
  ASCII 'IVX ' 
  'I' = 0x49, 'V' = 0x56, 'X' = 0x58 
  N = 1013, (1000 Data Bytes, 12 header bytes, 1 termination byte) 
 
Byte 3  Serial Status 
 

Bit 7 Bit 6 Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit 0  
1 = 

Character 
Overrun 

1 = 
Switches 
Accepted 

Packet 
Num 
Error 

Gain 
Switch 
Error 

Freq 
Switch 
Error 

Range 
Switch 
Error 

Channel  

      0 0 Port 
      0 1 Reserved 
      1 0 Starboard 
      1 1 Reserved 
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Byte 4 Range 
0x0A – 0xC8 
Operating range:  

Low Frequency: 10, 20, 30, 40, 50, 60, 80, 100, 125, 150, 200m 
Med Frequency: 10, 20, 30, 40, 50, 60, 80, 100, 125, 150, 200m 
High Frequency: 10, 20, 30, 40, 50m 
 

Byte 5  Frequency 
0. Low Frequency 
1. Medium Frequency 
2. High Frequency 

 
Byte 6  Firmware Version 
  0x00 
 
Bytes 7-9 Reserved 
  0 
 
Bytes 10, 11 Number of data bytes 
 
  Number of Echo Data Bytes returned 
  Data Bytes (LO), Data Bytes (HI) 
 

Byte 10 Byte 11 
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 

Data Bytes (HI) Data Bytes (LO) 

 
  Data Bytes = (Data Bytes High Byte<<8) | Data Bytes Low Byte 
 
Byte 12 Start of Echo Data 
  (N-12) Bytes of data 
 
   1st Range Point = Byte 12 
   2nd Range Point = Byte 13 
   3rd Range Point = Byte 14 
   4th Range Point = Byte 15 
   etc. ... 
 

Byte (N-2) End of Echo Data 
 
Byte (N-1) Termination Byte 
  0xFC 
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OVERVIEW  
 
When recording the YellowFin data to a .872 file, the following bytes are appended and saved to the file every ping. The total 
number of bytes ‘N’ for each ping is equal to 4096. 
 

Byte # Byte Description 
0-999 File Header (1000 bytes) 

1000-1999 Port Channel Echo Data (1000 bytes) 
2000-2999 Starboard Channel Echo Data (1000 bytes) 
3000-3nnn GPS Strings (100 bytes/string) 
3nnn-4093 Zero Fill  

 
 

4094-4095 

Pointer To Previous Ping 
The last 2 bytes of this ping contain a 16-Bit number that is the sum of the number 
of bytes for this ping and the number of bytes for the previous ping. This number 
can be used for reverse playback synchronization. 
Number of bytes to previous ping = ((Byte 4094)<<8) | (Byte 4095) 

 
FILE HEADER 
 
Bytes 0 through 999 contain the following File Header information: 
 
Byte 0  ASCII '8'  
Byte 1  ASCII '7'  
Byte 2  ASCII '2' 
 
Byte 3  872 File Version 
  0 = v1.xx – 1000 points/channel, 8-Bit data 
 
Bytes 4-7 Ping Number – increment for every ping 

Byte 4 Byte 5 Byte 6 Byte 7 
7 - 0 7 – 0 7 - 0 7 - 0 

Ping Number 

 
Bytes 8-9 Total Bytes ‘N’ - number of bytes that are written to the disk for this ping 

Byte 8 Byte 9 
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 

N = 4096 

 
Bytes 10-11 Data Points Per Channel 

Byte 10 Byte 11 
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 

1000 

 
Byte 12  Bytes Per Data Point 
  always 1 
 
Byte 13  Data Point Bit Depth 
  always 8 
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Byte 14  GPS Type/ Number of GPS Strings 
GPS Type indicates which NMEA 0183 message was selected by the user and used for decoding Lat/Lng 
coordinates. Number of GPS Strings indicates how many GPS strings were detected and stored. Each string 
is stored (in ASCII) exactly as it appeared at the serial communications port during real time data 
acquisition. The strings are stored in a 100 byte slots starting at GPS String File Offset (Bytes 15-16). 

 
Byte 14 

7 6 5 4 3 2 1 0 
GPS Type Number of GPS Strings 

 
  GPS Type: 
  0 � $GPGLL 
  1 � $GPGGA 
  2 � $GPRMC 
 
  NMEA 0183 GPS Strings stored at the following offsets: 
  $GPGLL: stored at GPS String File Offset + 0 
  $GPGGA: stored at GPS String File Offset + 100 
  $GPRMC: stored at GPS String File Offset + 200 
  $GPVTG: stored at GPS String File Offset + 300 
 
Bytes 15-16 GPS String File Offset 
 

Byte 15 Byte 16 
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 

Offset = 3000 

 
Bytes 17-18 Event/Annotation Counter 
 

Byte 17 Byte 18 
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 
E Count:   0 to 32767 

 
  E = 0, no event, ignore count 
  E = 1, new event, increment count and append annotation file. 
  Annotations are stored in “filename.an”. Each annotation contains a maximum of 512 characters. 
 
Bytes 19-30 Date – system date, null terminated string (12 bytes) 
  "DD-MMM-YYYY" 
 
Bytes 31-39 Time – system time, null terminated string (9 bytes) 
  "HH:MM:SS" 
 
Bytes 40-44 Thousandths of Seconds – system time, null terminated string (5 bytes) 
  ".ttt" 
 
Byte 45  Operating Frequency 
  0 = Low Frequency 
  1 = Medium Frequency 
  2 = High Frequency 
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Byte 46  Range Index – index numbers for acoustic operating range 
  5 - 10m 
  6 - 20m 
  7 - 30m 
  8 - 40m 
  9 - 50m 
  10 - 60m 
  11 - 80m 
  12 - 100m 
  13 - 125m 
  14 - 150m 
  15 - 200m 
 
Byte 47  Data Gain 
  0 to 100 percent 
 
Byte 48  Channel Balance 

 0 to 60 � +/-3dB in 0.1dB increments 
 0 = +3dB Port / -3dB Stbd 
 30 = 0dB for both channels 
 60 = -3dB Port / +3dB Stbd 

 
Bytes 49-50 Repetition Rate – Time between pings 
 

Byte 49 Byte 50 
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 

Repetition Rate (ms) 
 
Bytes 51-52 Sound Velocity 
 

Byte 51 Byte 52 
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 

Sound Velocity (in meters/second) * 10 
 
Bytes 53-64 12 Byte File Header. Refer to the section “Interface Return Data” in the document “YellowFin Ethernet 

Specification” for further details.  
 
Bytes 65-68  Altitude 
   4 byte floating point number (in meters) 
 
Bytes 69-999  Reserved - always 0 
 

Bytes 1000-1999  Port Channel Echo Data 
   1000 data points (1 byte/point) 
   first range point = 1 * Range / 1000 in meters 
   last range point = 1000 * Range / 1000 in meters 
   intensity: 0 – 255 
 

Bytes 2000-2999  Starboard Channel Echo Data 
   1000 data points (1 byte/point) 
   first range point = 1 * Range / 1000 in meters 
   last range point = 1000 * Range / 1000 in meters 
   intensity: 0 – 255 
 

Bytes 3000-3nnn  GPS Strings – (100 bytes/string) 
 
Bytes 3nnn-4093  Zero Fill  
 

Bytes 4094-4095  Pointer to Previous Ping 
 

Byte 4094 Byte 4095 
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 

Number of bytes to previous ping = 8192 
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IMAGENEX 
 

SINGLE BOARD ETHERNET DIGITAL SIDESCAN 
(170-025.v1) 

 

PING RATES 
 
 

RANGE 
(Meters) 

Ping Rate 
(PRF) 
(msec) 

 STORAGE 
(MByte/hr) 

10 53  ~265 
20 53  ~265 
30 60  ~235 
40 73  ~195 
50 87  ~160 
60 100  ~140 
80 126  ~110 

100 154  ~90 
125 187  ~75 
150 220  ~65 
200 286  ~50 

 
 
Using YellowFin_AUV.exe v2.008, D725SS4C, on Intel E5200 @ 2.5GHz, 2GB Ram, 
GeForce 7300SE running Windows XP Pro, Service Pack 2. 
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